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1. INTRODUCTION

Today, chemical explosives are used to launch projectiles, rockets and 
spacecraft. There are some limitations in increasing the speed of these sys-
tems. Chemical fuels cannot be reused, so their costs are high. Storage of 
chemical fuels is dangerous and the chemical reaction is difficult to con-
trol. Electromagnetic launchers have been discovered as an alternative to 
chemical launcher systems (Fair, 1982). The importance of electromag-
netic launchers has increased recently due to their many advantages such 
as high speed, reusability, flexibility and durability. Numerous industries, 
including the military, nuclear physics, space exploration, and medicine, 
use electromagnetic launchers.. 

1.1. Types of Electromagnetic Launchers

There are many types of launchers. Some of these are electromagnetic 
(EM), chemical, hydrostatic, elastic and gravity. Electromagnetic launch-
ers (EML) can be classified as induction, direct, electro-thermal-chemical 
(ETC), magnetic, electrostatic and hybrid. This classification is shown in 
Figure 1. 

Figure 1. Classification of Electromagnetic Launchers.
Rail launchers (RAL) and reluctance launchers (REL) are the most 

studied EML. RAL are the constant specific force type of the direct class. 
REL are the variable specific force type of the direct class (Engel, 2017).

1.1.1. Rail Launchers (Rail Gun)

There are typically three different types of RAL based on rail structure: 
conventional RAL, augmented RAL, and barrel-fed RAL (Yu and Fan, 
2010). The most commonly used conventional RAL have two rails and a 
movable conductive armature that short-circuits these rails. When voltage 
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is applied to the rails, the conductive armature short-circuits the rails and 
a current flows through the rails. This current produces a magnetic field. 
The armature moves with the Lorentz force that occurs as a result of the 
magnetic field and throws the object to be thrown (Keshtkar et al., 2008). 

Figure 2. Rail gun.
RAL can reach high speeds (higher than 2000 m/s) and their efficiency 

can exceed 30% (Lehmann et al., 2006). RAL are large in size. For this 
reason, it is not portable and must be mounted on a fixed place or vehicle. 
RAL are mostly suitable for use in land and sea vehicles. The representa-
tion of the RAL, also known as the rail gun (Tzeng and Schmidt, 2010), 
is shown in Figure 2, and the equivalent circuit of the RAL (Zhang et al., 
2010) is shown in Figure 3.

Figure 3. Equivalent circuit of rail gun.

1.1.2. Coil Launchers (Coil Gun)

Another name for coil launchers (CL) is coil gun (CG). In CG, coils 
are used to launch the object to be thrown. CG may have one coil or mul-
tiple coils (Marder, 1993). CG consist of two main parts; mechanical part 
and electronic part. The mechanical section consists of three subsections.

1. Winding

2. Barrel (the pipe through which the object to be thrown will move)

3. Projectile (The object to be thrown)
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In the electronic part, there are power supply and control circuits. 
When a current flows through the winding, a magnetic field is created 
around the winding. The object to be thrown is thrown with the effect of 
this magnetic field. CG can be generally divided into induction coil guns 
(ICG) and reluctance coil guns (RCG) (Daldaban and Sari, 2016). There 
are also electromagnetic launchers where induction and REL are used to-
gether (Jing et al., 2017).

1.1.2.1. Induction Coil Gun

The projectile launched in ICG is not ferromagnetic, but paramag-
netic or diamagnetic. The projectile is not pulled, it is pushed. Therefore, 
the projectile must stay outside the part of the coil that is intended to be 
launched. The operation of ICG is related to eddy currents (Slade, 2005). 
Figure 4 shows the ICG, and Figure 5 shows the equivalent circuit of the 
ICG.

Figure 4. Induction coil gun (Liu et al., 2010).

Figure 5. Equivalent circuit of induction coil gun (McKinney and Mongeau, 
1984).
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1.1.2.2. Reluctance Coil Gun

The operation principle of RCG is similar to reluctance motors (Ch-
aowei et al., 2008). The projectile to be launched in RCG must be made of 
ferromagnetic material. The projectile is moved toward middle of the coil 
by RCG. The projectile cannot be pushed. (Mosallanejad and Shoulaie, 
2012). When current flows through the coil, a magnetic field is created. 
This magnetic field wants to use the projectile as a bridge (due to the mag-
netic permeability of the ferromagnetic projectile being much higher than 
air) and therefore pulls the projectile towards the center of the coil. The 
coil’s energy should be cut off and the coil’s energy should be absorbed 
when projectile reaches the middle of the coil. Otherwise, the projectile 
cannot be thrown or it will be thrown slowly because the projectile will be 
pulled in the opposite direction and again to the center of the coil. This is 
the most important point in the design of RCG. The efficiency of the RCG 
is very dependent on this timing. In multi-stage RCG, energy must be giv-
en to the relevant coil according to the position of the projectile, and when 
the projectile reaches the center of that coil, the energy of that coil must be 
cut off and the energy in that coil must be absorbed. Sensors can be used 
to energize and disconnect the coils. These sensors are shown in Figure 6 
(Daldaban and Sari, 2014). After the coil is de-energized, a parallel diode 
can be connected to absorb the energy in the coil. This parallel diode is 
shown in Figure 7 (Bresie and Andrews, 1991).

Figure 6. Reluctance coil gun.
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Figure 7. Equivalent circuit of the reluctance coil gun.
Figure 7 shows the equivalent circuit of the RCG. While switch S2 

is open, switch S1 is closed and the capacitors are charged. Subsequently, 
the energy within the capacitor is transferred to the coil when switch S1 
is opened and switch S2 is closed. In order to switch the energy given 
to the coil, semiconductor circuit elements such as thyristors, transistors, 
MOSFETs and IGBT, which can operate at high voltages, should be used 
as switching elements. While the trigger circuits of these semiconductor 
circuit elements operate at relatively low voltage, the voltage applied to the 
coil is high. Therefore, these circuit elements must be used with a driver. 
In addition, a damping circuit should be used to protect against damage 
that may occur from on and off states. The damping circuit may consist of 
diode, capacitor and resistor.

Figure 8. Force applied to the projectile vs distance.

Figure 8 shows the change of the force exerted on the projectile in the 
REL depending on the distance. Here the zero point is the middle point 
of the coil. When the projectile passes the midpoint of the coil, the force 
applied to the projectile is in the opposite direction, that is, the projectile is 
pulled back to the center of the coil (Bresie and Andrews, 1991).
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In REL, the acceleration of the projectile can be found with Equation 
1 (Chaowei et al., 2008). Here

la= projectile length,

ρ= material density of the projectile

NI= magnetomotive force

l= coil length

Given that the RCG’s projectile is ferromagnetic and the B-H curve 
of the ferromagnetic material is nonlinear, it is difficult to determine the 
performance of REL. For this purpose, the finite element method (FEM) is 
used. FEM is an analysis method used to analyze problems that cannot be 
solved or are difficult to solve with known methods (Daldaban and Sari, 
2015). In many previous studies, FEM was used to analyze REL (Daldaban 
and Sari, 2014; Daldaban and Sari, 2016; Sari and Daldaban, 2019; Ch-
aowei et al., 2008; Yadong et al., 2010; Hou et al., 2012). There are many 
computer programs that can perform solutions with FEM. The most pop-
ular of these is the ANSYS Maxwell program. ANSYS Maxwell may be 
used to create a three-dimensional model of the REL. and the desired data 
can be obtained by solving it with FEM.

1.1.3. Hybrid Electromagnetic Launchers

Hybrid launchers are the combination of RAL and CL. Therefore, they 
have the characteristics of both RAL and CL (Shiyong et al., 2004).

2. VELOCITY MEASUREMENT SYSTEMS

Measuring the velocity of the launched projectile is an important is-
sue regarding EML. As examples of velocity measurement systems; Ultra-
sonic velocity measurement systems, laser velocity measurement systems 
and velocity measurement systems using optical sensors can be given. The 
most used and most sensitive velocity measurement system is the velocity 
measurement system using optical sensors. In this velocity measurement 
system, two pairs of optical sensors are placed consecutively on the path 
of the projectile. If the time the projectile passes through these sensors is 
measured and the distance between the sensors is divided by this time, the 
velocity of the projectile can be found (Daldaban and Sari, 2016).
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Figure 9. Measurement of projectile velocity with optical sensors.

3. GENERATING A 3D MODEL OF A RCG

Before realizing REL, the FEM model of the REL must be generated 
and analyzed. This is an important step to solve problems encountered in 
practice and optimize the system. Before generating the launcher model, 
the physical dimensions of the launcher (projectile thickness, projectile 
length, barrel inner and outer diameter, coil length and coil height) must 
be determined. The diameter and number of turns of the wire used in the 
coil must be determined, and the dimensions of the coil when it is wound 
must be determined. Figure 10 provides the launcher’s dimensions. Here, 
the outer diameter of the barrel is 10 mm, the inner diameter of the barrel 
is 8 mm, the projectile length is 25 mm, the projectile diameter is 7 mm, 
the coil length is 50 mm, the coil diameter is 28.6 mm and the barrel length 
is 200 mm.

Figure 10. Dimensions of the launcher.
A 3D model of a RCG can be generated using the ANSYS Maxwell 

program, which can solve with FEM. Initially, after opening the program, 
click on the “Insert Maxwell 3D Design” section from the “Project” tab or 
click on the “Insert Maxwell 3D Design” icon. The name “Project1” in the 
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“Project Manager” section can be changed. A desired name is given instead 
of “Project1”. In this study, it was named “3D_RF”. To select the solution 
type, click “Solution Type” from the “Maxwell 3D” tab. Select “Transient” 
from the window that opens on the screen.

To generate the inside of the barrel, click “Regular Polyhedron” from 
the “Draw” tab or click the “Draw Regular Polyhedron” box. The start-
ing coordinate, inner radius coordinate, and barrel length coordinate are 
entered in the coordinate boxes in the lower right corner of the program 
screen. The Enter key is pressed each time. Segment number is entered. 
Then click on “RegularPolyhedron1” in the “Model” section, its name can 
be changed in the “Properties” section, in this study it is entered as “In-
sideBarrel”. Material is changed in the “Properties” section, “vacuum” is 
selected by default. Select “air” from the “Edit” section.            

To generate the barrel, click “Regular Polyhedron” from the “Draw” 
tab or click the “Draw Regular Polyhedron” box. The starting coordinate, 
outer radius coordinate, and barrel length coordinate are entered in the co-
ordinate boxes in the lower right corner of the program screen. The En-
ter key is pressed each time. Segment number is entered. Then, click on 
“RegularPolyhedron1” in the “Model” section, its name can be changed 
in the “Properties” section, in this study it is entered as “Barrel”. Material 
is changed in the “Properties” section, “vacuum” is selected by default. 
Select “PVC plastic” from the “Edit” section. If desired, the color of the 
barrel can be changed by selecting a desired color from the “Color” section 
in the “Properties” section.

To obtain a hollow tubular barrel, the “InsideBarrel” must be removed 
from the generated “Barrel”. To do this, “Barrel” and “ InsideBarrel “ in 
the “Model” section are selected together by holding down the Ctrl key. 
Then click on the “Subtract” command from the “Boolean” section of the 
“Models” tab. In this box, there should be “ Barrel” on the left and “ In-
sideBarrel “ on the right. 

In order to model the current flowing through the coil, a rectangle 
should be generated in the coil cross section on the “YZ” axis and exci-
tation should be given from this rectangle. For this purpose, “YZ” is select-
ed from the “Grid Plane” section in the “Models” tab. From this moment 
on, the drawings will be relative to the “YZ” axis. From the “Draw” tab, 
click the “Rectangle” command. Coordinates are entered in the coordinate 
section in the lower right corner. The Enter key is pressed each time. The 
model obtained with what has been done so far is shown in Figure 11.
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            Figure 11. Steps to generate the model.
While “Rectangle1” is selected in the “Model” section, “Copy” and 

then “Paste” commands are clicked and “Rectangle2” is generated. While 
“Rectangle2” is selected, click “Around Axis” in the “Sweep” section of 
the “Draw” tab. Click on the “Z” axis in the opened box. Here, “Angle of 
sweep” should be 360 degrees. Thus, the coil is generated. Click “Rectan-
gle2” in the “Model” section and its name can be changed in the “Prop-
erties” section. Here it has been changed to “Coil”. In the “Properties” 
section, click on “vacuum” in the “Material” section and select “Copper”. 
The model obtained with what has been done so far is shown in Figure 12.

Figure 12. Steps to generate the model.
To generate the projectile, select “XY” from the “Grid Plane” sec-

tion of the “Models” tab. From now on, plots will be relative to the “XY” 
axis. From the “Draw” tab, click “Regular Polyhedron” or click the “Draw 
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Regular Polyhedron” box. The starting coordinate is entered in the coor-
dinate boxes in the lower right corner of the program screen, the radius 
coordinate of the projectile is entered, and the projectile length coordinate 
is entered. The Enter key is pressed each time. Segment number is entered. 
Click on “RegularPolyhedron1” in the “Model” section, change its name 
in the “Properties” section, and in this study it is entered as “Projectile”. 
Material is changed in the “Properties” section, “vacuum” is selected by 
default. A desired ferromagnetic material is selected from the “Edit” sec-
tion, “steel_1010” is selected here. If desired, the color of the projectile 
can be changed by selecting a desired color from the “Color” section in the 
“Properties” section.

To excite the coil, select “Rectangle1” in the “Model” section we gen-
erated previously. Then click on “Excitations” from the “Maxwell 3D” 
tab, then click on “Coil Terminal” from the “Assign” section. The number 
of coil windings is entered in the “Number of Conductors” section in the 
window that opens. Right-click on “Excitations” among the project items 
in the “Project Manager” section and click on “Add Winding” from the 
menu that opens. In the sections in the window that opens, how the coil 
will be excited (Voltage, Current), starting current, the value of the voltage 
to be applied, the resistance and inductance values of the coil are entered. 
Right-click “Winding1” in the “Project Manager” section and click “Add 
Terminals” from the menu that opens. Select “Coil Terminal” in the opened 
box. Thus, the excitation of the coil is completed.

To generate the section where the projectile will move inside the bar-
rel, click “Regular Polyhedron” from the “Draw” tab or click the “Draw 
Regular Polyhedron” box. The starting coordinate is entered in the coordi-
nate boxes in the lower right corner of the program screen, the movement 
section radius coordinate is entered, and the movement section length co-
ordinate is entered. The Enter key is pressed each time. Segment num-
ber is entered. Click on “RegularPolyhedron1” in the “Model” section, 
change its name in the “Properties” section, and in this study it is entered 
as “Band”. Material is changed in the “Properties” section, “vacuum” is 
selected by default. “air” is selected in the “Edit” section because the pro-
jectile will move in the air in the pipe. If desired, the color of the projectile 
can be changed by selecting a desired color from the “Color” section in the 
“Properties” section. The model obtained with what has been done so far 
is shown in Figure 13.
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Figure 13. Steps to generate the model.
While “Band” is selected in the “Model” section, right-click on “Mod-

el” in the “Project Manager” section, click “Motion Setup” from the menu 
that opens, then click “Assign Band”. In the “Positive” section of the 
“Data” tab of the window that opens, the length that the projectile will 
travel in the barrel is entered. Click “Consider Mechanical Transient” in 
the “Mechanical” tab, enter the weight of the projectile in the “Mass” sec-
tion. The program can calculate the weight of the projectile. If desired, the 
weight of the projectile can be calculated by clicking “Calculate”.

“Coil” is selected from the “Model” section, then “Mesh Operations”, 
“Assign, Inside Selection” and “Lenght Based” are clicked on the “Max-
well 3D” tab. In the window that opens, uncheck “Set maximum element 
length” and tick “Maximum number of additional elements” and write the 
desired value in front of it.

Select “Projectile” from the “Model” section, then click on “Mesh Op-
erations”, “Assign, Inside Selection” and “Lenght Based” from the “Max-
well 3D” tab. In the window that opens, uncheck “Set maximum element 
length” and tick “Maximum number of additional elements” and write the 
desired value in front of it.

To define the area to be analyzed, click “Box” on the “Draw” tab and 
enter the analysis boundaries in the coordinate section at the bottom right.

From the “Maxwell 3D” tab, click “Analysis Setup” and then “Add 
Solution Setup”. The simulation time is entered in the “Stop time” section 
in the “General” tab of the opened window, and the simulation step time 
is entered in the “Time step” section. After entering the simulation time in 
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the “Stop” section of the “Save Fields” tab and the simulation step time in 
the “Step Size” section, click the “Add to List” button.

To add eddy current loss to the model, click “Excitations” and then 
“Set Eddy Effects” from the “Maxwell 3D” tab. “Coil” and “Projectile” are 
ticked in the window that opens. Thus, the eddy current loss in the coil and 
projectile is added to the model.

From the “Maxwell 3D” tab, click “Validation Check”. All those listed 
on the right should have a green check mark at the beginning. There are 
errors in the parts without green markings and these should be corrected. 
From the “Maxwell 3D” tab, click “Analyze All”. The program simulation 
runs. Figure 14 shows the final view of the model.

Figure 14. Final version of the model.
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Figure 15. Projectile velocity change.
From the “Maxwell 3D” tab, click “Results”, “Create Transient Re-

port”, “Rectangular Plot”. A graph can be drawn by selecting the parameter 
whose graph you want to draw in the window that opens. For example, 
for projectile velocity, “Speed” is selected in the “Category” section, and 
if “New Report” is clicked, the projectile velocity graph screen over time 
opens. If you want to draw a graph of the force applied to the projectile, 
click “Results”, “Create Transient Report”, “Rectangular Plot” from the 
“Maxwell 3D” tab. If “Force” is selected from the “Category” section in 
the opened window, “Moving1.Force_z” is selected from the “Quantity” 
section and “New Report” is clicked, a graph of the force applied to the 
projectile on the Z axis is drawn according to time.

Figure 16. Change of force applied to the projectile.

Figure 17. Change of the projectile position.
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Figure 15 shows the projectile velocity change graph, Figure 16 shows 
the change graph of the force applied to the projectile, and Figure 17 shows 
the change graph of the projectile position. When these graphics are ex-
amined, the projectile velocity reached its highest value in the 4.5th milli-
second with 20.708 m/sec. At this moment, the force applied to the coil is 
close to zero and the position of the projectile is very close to the middle of 
the coil, at 37.479 mm (37.5 mm is in the middle of the coil). At the 4.5th 
millisecond, the energy applied to the coil must be cut off and the energy in 
the coil must be absorbed, otherwise the projectile ‘s muzzle velocity will 
decrease as the projectile will be pulled back to the middle of the coil. As 
shown in Figure 16, if the energy applied to the coil is not cut off within 4.5 
milliseconds, a force acts in the opposite direction on the projectile and the 
projectile velocity decreases or even becomes negative, as shown in Figure 
15. In other words, the projectile is drawn back into the middle of the coil. 
As shown in Figure 17, the projectile reaches its furthest position at 72.197 
mm in 7.3 milliseconds, and from this point onwards its position decreases, 
that is, it is drawn back into the coil.

The Maxwell program solves the problem by dividing the system 
into small pieces according to finite element analysis. To see the launcher 
divided into small pieces, select the relevant part of the launcher, right-
click on “Fields Overlays” in the “Project Manager” section, and click on 
“Plot Mesh” from the menu that opens. Figure 18 and Figure 19 show the 
launcher divided into small parts.

Figure 18. Division of the barrel and coil into small areas according to the finite 
element method.
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Figure 19. Division of the projectile and coil into small areas according to the 
finite element method.

The magnetic field examination of the launcher can also be done with 
the Maxwell program. To do this, right-click on “Field Overlays” in the 
“Project Manager” section while the part of the launcher that you want 
to examine is selected or all its components are selected. From the menu 
that opens, click “Fields”, “B”, “Mag_B”. The time to be examined in the 
simulation is selected. Figure 20 shows the magnetic field at 1 msec. With 
the colored scaling on the top left, you can see how much magnetic field is 
in which part of the launcher. As shown in Figure 20, the magnetic field in 
the coil is around 0.5 T - 1 T. Figure 21 shows the magnetic field at 4.5 ms. 
Here the projectile is in the middle of the coil.

Figure 20. Magnetic field of the launcher at 1 ms.
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Figure 21. Magnetic field of the launcher at 4.5 ms.

4. CONCLUSION

In this study, a 3D model of a REL was generated and the effect of 
launcher parameters on projectile velocity was examined. At the end of the 
investigations, it was seen that a launcher with a higher velocity could be 
obtained by changing the launcher parameters. Choosing the correct pa-
rameters of EML is important in terms of projectile velocity and efficiency 
of the system. If chosen incorrectly, the muzzle velocity of the launcher 
and the efficiency of the system will decrease.

Optimization studies can be carried out by changing the launcher pa-
rameters to increase the launcher’s projectile velocity. In previous studies 
(Daldaban and Sari, 2014) (Daldaban and Sari, 2015) (Sari and Daldaban, 
2019), it was examined how projectile material and shape affect projectile 
speed. It is possible to increase the projectile velocity by changing other 
parameters. These parameters; It may be the inner and outer diameter of 
the barrel, the length of the coil, the number of windings, the thickness of 
the coil wire, and the diameter of the coil. By changing these parameters, 
optimization can be made without building the launcher, thus saving time 
and cost can be achieved by determining the parameters of the launcher 
with the highest velocity.



72  . Vekil SARI

REFERENCES
Bresie, D. A., & Andrews, J. A. (1991). Design of a reluctance accelerator. IEEE 

Transactions on Magnetics, 27(1), 623-627.

Chaowei, Z., Pengshu, D., Xiaojun, D., Sanqun, L., Zhiyuan, L., & Guanghui, Z. 
(2008, October). Analysis of reluctance coil launcher performance using 
coupled field-circuit method. In International Conference on Electrical Ma-
chines and Systems, Wuhan/China, (pp. 4049-4052).

Daldaban, F., & Sari, V. (2016). The optimization of a projectile from a three-coil 
reluctance launcher. Turkish Journal of Electrical Engineering and Com-
puter Sciences, 24(4), 2771-2788. 

Daldaban, F., & Sari, V. (2015). Bir Relüktans Fırlatıcının Sonlu Elemanlar Yön-
temi ile İncelenmesi. Gazi Üniv. Müh. Mim. Fak. Der, 30(4), 605-614.

Daldaban, F., & Sari, V. (2014, September). Design and implementation of a three-
coil linear reluctance launcher. In 16th International Power Electronics and 
Motion Control Conference and Exposition, Antalya/Turkey, (pp. 1084-
1088).

Engel, T. G. (2017). Scientific classification method for electromagnetic launch-
ers. IEEE Transactions on Plasma Science, 45(7), 1333-1338.

Fair, H. (1982). Electromagnetic propulsion: A new initiative. IEEE Transactions 
on Magnetics, 18(1), 4-6.

Hou, Y., Liu, Z., Ouyang, J. M., & Yang, D. (2012, May). Parameter settings of the 
projectile of the coil electromagnetic launcher. In 16th International Sym-
posium on Electromagnetic Launch Technology, Beijing/China, (pp. 1-4).

Jing, B., Liao, T., Jiang, T., Chen, L., & Jia, X. (2017, November). Optimal design 
and simulation of combined reluctance-induction electromagnetic launch-
er. In Progress in Electromagnetics Research Symposium-Fall, Singapore, 
(pp. 1377-1381).

Keshtkar, A., Bayati, S., & Keshtkar, A. (2008, June). Effect of rail’s material on 
railgun inductance gradient and losses. In 14th Symposium on Electromag-
netic Launch Technology, Victoria, BC, Canada,  (pp. 1-4).

Lehmann, P., Reck, B., Vo, M. D., & Behrens, J. (2006). Acceleration of a subor-
bital payload using an electromagnetic railgun. IEEE transactions on mag-
netics, 43(1), 480-485. 

Liu, W., Cao, Y., Zhang, Y., Wang, J., & Yang, D. (2010). Parameters optimization 
of synchronous induction coilgun based on ant colony algorithm. IEEE 
Transactions on Plasma Science, 39(1), 100-104.

Marder, B. (1993). A coilgun design primer. IEEE transactions on magnetics, 
29(1), 701-705.

McKinney, K., & Mongeau, P. (1984). Multiple stage pulsed induction accelera-
tion. IEEE Transactions on Magnetics, 20(2), 239-242.



 . 73Research And Evaluations In Engineering - 2023 December

Mosallanejad, A., & Shoulaie, A. (2012). A novel structure to enhance magnetic 
force and velocity in tubular linear reluctance motor. Turkish Journal of 
Electrical Engineering and Computer Sciences, 20(7), 1063-1076.

Sari, V., & Daldaban, F. (2019). Examination of the effect of different projectile 
geometries on the performance of reluctance launcher using 3D finite ele-
ment analysis. Cumhuriyet Science Journal, 40(2), 518-526.

Shiyong, Y., Ying, W., Shanbao, C., Qian, L., Xuqiong, L., & Wei, W. (2004, 
May). A novel type rail-coil hybrid electromagnetic launcher. In 12th Sym-
posium on Electromagnetic Launch Technology, Snowbird, UT, USA, (pp. 
155-157).

Slade, G. W. (2005). A simple unified physical model for a reluctance accelerator. 
IEEE transactions on magnetics, 41(11), 4270-4276.

Tzeng, J. T., & Schmidt, E. M. (2010). Comparison of electromagnetic and con-
ventional launchers based on Mauser 30-mm MK 30-2 barrels. IEEE 
Transactions on Plasma Science, 39(1), 149-152.

Yadong, Z., Ying, W., & Jiangjun, R. (2010). Capacitor-driven coil-gun scaling 
relationships. IEEE Transactions on Plasma Science, 39(1), 220-224.

Yu, X., & Fan, Z. (2010). Simulation and two-objective optimization of the elec-
tromagnetic-railgun model considering VSEC resistance and contact resis-
tance. IEEE Transactions on Plasma Science, 39(1), 405-410.

Zhang, Y., Ruan, J., & Wang, Y. (2010). Scaling study in a capacitor-driven rail-
gun. IEEE transactions on plasma science, 39(1), 215-219.


	VekilSARI Kitap Bölümü
	VekilSARI DavetMektubu
	VekilSARI Sözleşme
	VekilSARI UluslararasiYayınevi
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